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P. O. Box 59567, Schaumburg, IL 60159-0567
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If you are like most genealogists today, you have probably spent
untold hours in front of a computer screen looking at other people's
web sites. Finding a site that gives information about ancestors that
might possibly be yours is a great way to connect to others with
whom you might share research. But what if you could have your own
site so that others can find you! Yes, you can create a web site of
your own. In this presentation we will discuss what you might want to
include on your site, hints on how to arrange your information, and
most importantly, how to create a document that can be read by
your browser and displayed as a web page complete with pictures,
links, and formatted text (all about your ancestors, of course.)

Virginia Jenkins has been working with computers off and on
since the 1960's, both as a user and as a programmer, and has been
involved with genealogy for at least 25 years. She has developed web
sites for her business and her genealogy, and is on the web site
committee at her church. She is currently owner of MicroManager
Software Services where she writes software to help libraries man-
age their periodical collections.

Tool Tips for
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July 20, 2002
Trust Your Research to

BEVERLY LEVINE SMALLWOOD

Our CAGG-NI President
will demonstrate Bygones, a
Basic Genealogical Note-
Keeping System to organize
your research notes and logs.

August 17, 2002
Tips and Tricks to

Stretch Family Tree
Maker

DAN NIEMIEC
Dan will show how to

make the most use of Family
Tree Maker to improve cus-
tom reports and to help or-
ganize your research. Even if
you’re not a FTM user, you
can apply these techniques to
the your software program.

June 15, 2002

Creating Your
Own Web
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May Meeting Notes
by Anne Jacobs

Map Maker, Map Maker, Make Me a
Map

Maps are such interesting things.  They tell stories
all by themselves.  Much insight can be gained into our
lives and that of our ancestors.

Chris took us on a journey into the world of maps
and how we can use them to learn our ancestor’s story
as well as tell our family story.

Chris Kite’s presentation started by harking back
to a previous program, DNA Molecular Genealogy.  One
of the first Internet links he had for us was Brigham
Young University’s update on the DNA project.  The
site has maps of gene migrations.  This will show how
various lines began to populate the world.

Chris showed that knowing the topography of an
area can explain the route our migrating ancestors took.
Or, studying topography will give us clues on where to
look for their next move.

Some of the maps Chris selected depicted political
developments such as the Principal Seats of War in Eu-
rope and Napoleon’s Army in Russia.  One interesting
map showed Poland’s borders over the years.  At one
time, Poland encompassed much of the Baltic states.

Another map showed how long it took to travel
across the United States at various times in US history.
For instance, it showed that in the early 1800s, you could
only travel a short distance from New York City in one
day.  Once the railroads opened the “frontier”, you could
get half way to Chicago in the same time.  Airplane travel
changed this map again.  These developments show much
about the life of our ancestors.

Chris also showed a map he had recorded the loca-
tion of his ancestors.  Starting with a map of his ancestor’s
homeland, he “updated” the map with their surnames
showing how close/far various lines of the family re-
sided.  Visual depictions like this help tell a family’s story
in an interesting way.

This presentation gave me some ideas of how I could
use maps to add “meat to the bones” I have been col-
lecting.  It also gave me some web sites to start with.  A
copy of the meeting handout is included in this newslet-
ter.

Harold and June Bodinet surprised us with a
rhubarb cake made with rhubarb from their own garden.
Delicious!!!  Others also contributed, including Paul
Cord.  Lynn Haider and Harold Bodinet managed the
kitchen and coffee making.  Thanks!

CAGG-NI Fund Raiser

Shop & Share
Our next Shop & Share days are July 1st through

the 3rd. You may follow this link to print out as many
coupons as you require. http://www.rootsweb.com/
~ilcaggni/shops2h.htm We will be distributing
printed coupons at our meeting this month as well. All
you need do is shop at Jewel-Osco on one of our three
assigned dates, then sign and turn in coupon as you check
out. The cashier will record the total of your purchases.
Once all the coupons are collected and tallied, Jewel
will contribute 5% of the total to CAGG-NI. Please give
coupons to your family, friends, co-workers, and neigh-
bors. The only caveat is that the coupons may not be
distributed in or near a store.

http://www.rootsweb.com/~ilcaggni/shops2h.htm
http://www.rootsweb.com/~ilcaggni/shops2h.htm
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Genealogy Mentors Larry Olson
Geneva Shay
Patricia Weisshaus
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President’s Letter

Beverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine Smallwood

I'm baaack!  I was unable to attend last month's meet-
ing because I was at the National Genealogical Society
conference in Milwaukee.  What a great way to get your
batteries charged, as it were!  There were topics cover-
ing the full spectrum of experience, not to mention the
exhibit hall.  Since it was close to home, I ran into many
familiar faces, including many CAGG-NI members.  Of
course, I spent a lot of time in the exhibit hall at the
TMG booth.  I got a chance to see the newest version in
action, a little less than a week before its release.

As you know from Anne's email, TMG version 5
was released on May 22nd.  WOW!  I look forward to
exploring all features and enhancements.  Since the ini-
tial release is missing some features, I don't expect all
TMG users will make the switch right off the bat.  You'll
find an article elsewhere in this newsletter written pri-
marily about version 4, but with some version 5 instruc-
tions for those who have already made the leap.

Here's a couple of web notes:

The Illinois State Archives posted the Illinois State-
wide Death Index 1916–1950 on their website.  The web
site notes that you may order copies of original death
records from 1916 through 1947 from the Illinois State
Archives online request form, but death certificates af-
ter 1947 should be directed to the Illinois Department
of Public Health.  I would suggest, however, that order-
ing from the county would probably be less expensive,
depending on the county.  Find it at: <http://
www.cyberdriveillinois.com/departments/ar-
chives/genealogy/forms/idphdeathsrch.html>
or check out their other databases at:  <http://
www.sos.state.il.us/departments/archives/
databases.html>.

The National Archives gave their website a com-
plete overhaul.  They have expended a great deal of ef-
fort to make the whole site easier to use.  There are
links to various other sites, online articles, and links to
"printer friendly" page layouts.  I particularly appreciate
the Prologue articles now online.  Take a minute to ex-
plore <http://www.archives.gov/research_room/
genealogy/index.html>.

The Census Bureau posted a 149 page booklet in,
you guessed it, pdf format.  Review Measuring America:
The Decennial Censuses From 1790 to 2000 at <http:/
/www.census.gov/prod/2002pubs/pol02-

ma.pdf>.  There are images of many of the various
forms and a brief review of the questions and instruc-
tions given to the enumerators with emphasis on the
earlier years.  You'll want to supplement this with the
more detailed enumerator instructions posted at IPUMS
USA:  <http://www.ipums.umn.edu/~pipums/
voliii/tEnumInstr.html>.

Have you run across any interesting sites lately?
Drop me a line.  I'm also waiting for your contributions,
large and small, to the library database. If you’re read-
ing this on line, and you should be, I’m just one click
away (click on my name).

See you soon,

mailto:Caggni_Bev@yahoo.com
mailto:PatJW28@interaccess.com
mailto:CDouglas1@ameritech.net
mailto:RESommer@aol.com
mailto:mebreslin98@Yahoo.com
mailto:JimboDeuce@Yahoo.com
mailto:ROPulse@aol.com
mailto:Ancestorseeker@attbi.com
mailto:PatJW28@interaccess.com
mailto:Caggni_Bev@yahoo.com
http://www.cyberdriveillinois.com/departments/archives/genealogy/forms/idphdeathsrch.html
http://www.cyberdriveillinois.com/departments/archives/genealogy/forms/idphdeathsrch.html
http://www.cyberdriveillinois.com/departments/archives/genealogy/forms/idphdeathsrch.html
http://www.sos.state.il.us/departments/archives/databases.html
http://www.sos.state.il.us/departments/archives/databases.html
http://www.sos.state.il.us/departments/archives/databases.html
http://www.archives.gov/research_room/genealogy/index.html
http://www.archives.gov/research_room/genealogy/index.html
http://www.census.gov/prod/2002pubs/pol02-ma.pdf
http://www.census.gov/prod/2002pubs/pol02-ma.pdf
http://www.census.gov/prod/2002pubs/pol02-ma.pdf
http://www.ipums.umn.edu/~pipums/voliii/tEnumInstr.html
http://www.ipums.umn.edu/~pipums/voliii/tEnumInstr.html
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Chicagoland Family
History Centers

Schaumburg FHC News (Cook County)
1320 West Schaumburg Road

1-847-885-4130
Hours: Tues.-Thurs. 9:00am-9:00pm,

Sat. 9:00am-1:00pm
Closed Sunday, Monday and Friday
Closed: July, Thanksgiving week,

2 weeks over Christmas & New Years
Always call to confirm hours

This FHC has really expanded its CD collection.  It now has
all the CDs offered by Salt Lake City’s CD holdings.  Part of this
acquisition is all the Pedigree File CDs.  An Internet connection
has been planned for the FHC and will soon become active.  There
will be a 2 hour limit during busy times.

June Puzzler:

Can I rotate the axis of my Excel worksheet so the
rightmost row becomes column headings?  (Rows are
numbered down the left hand side and columns are
headed by letters in a spreadsheet.)

June Puzzler Answer:

What’s the Buzz?
Collected by Anne Jacobs

CAGG-NI’s newsletter contains links to Internet sites and is
not responsible for the content located on or through, any such
third-party sites.  You should always take care when downloading
and using software from the Internet.  Permission has been granted
to duplicate in the newsletter.

Hi All,

On Thursday, I was at the National Genealogical Society's
conference where I heard David Rencher's presentation on "Up-
to-Date in SLC: What's Happening at the FHL?"  Until two weeks
ago, Mr. Rencher was the director of the FHL in SLC.

I thought you might be interested in some of the information
he gave us, and I apologize to those of you who will get this mes-
sage twice because you are on both of the mailing lists I am send-
ing this to.

LDS is currently filming 4,000 rolls of microfilm per month.
There are 240 cameras currently filming in 44 counties.

They are working on how to convert records from microfilm
to digitization so the information can get to the public faster and
more conveniently. They are now filming information up to 1930.
April, May, September, and October are the peak times at the
FHL.

They have added a computer with a CD burner that can burn
images from microfilm to a formatted CD at the FHL.  They have
3 more (if I remember correctly) waiting to be set up.

People have requested that a particular location's records be
filmed.  Mr. Rencher said what they look for when they decide to
film is, if the depository has a large collection, and if they can be
at the depository for weeks or months for one continuous period
because of the time it takes to set up and breakdown the equip-
ment.

Some statistics:  the FHL was established in 1894, the IGI
started in 1969, in 1964 the first FHCs were established.

They have just released Pedigree Resource file disks #36 -
#40.  They were selling them at the conference for $20.

If you want to contact the FHL, their e-mail address is
mailto:FHL@LDSCHURCH.org.

I asked Mr. Rencher when they were going to distribute a
new catalog on CD.  He told us that they were selling them at the
FHL booth at the conference.  Naturally, we all went there only to
find out that they were not selling them.  We were told that it
would probably be another two to four weeks.

 Now for the bad news:

 I recently received a message on a mailing list that said that
LDS was Soundexing the 1930 census.  I asked Mr. Rencher if
this was true.  He said, "No."  He also said that they would never
just Soundex something - if they were going to do anything, they
would do an index.  Also, he said that after doing the 1880 cen-
sus, they learned that they never want to do another census.

Sandra Trapp

Select the rows you want to make into column head-
ings.  This is accomplished by clicking the first row, hold
down the right mouse button and move down to the last
item of interest.  Now the items of interest (cells) should
be highlighted.  Copy this selection by either using the
“copy” on the Edit menu or by clicking on the “copy”
icon on the toolbar.  Select a cell outside the cells being
copied.  Under the Edit menu, select “Paste Special”.  A
new dialog box opens.  Select the “Transpose” option in
this dialog box; then click “OK”.  The row headings are
now column headings.  You can clean up your new
spreadsheet by deleting the excess area.  I used this trick
to take a list of documents and make it into a check list
of what documents I had obtained for various ances-
tors.  After changing the list into column headings, I
started entering ancestor names into the first column and
just checked away under the appropriate column head-
ings.

mailto:FHL@LDSCHURCH.org
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By Christine L. Clark

Two of the best places in the Chicago area to get genea-
logical data are the Newberry Library and your local LDS
Family History Center (FHC).  Both have magnificent col-
lections, which are readily available to the public, but both
have copying rules.

The primary goal of the Newberry Library rules is to
preserve the actual original material. Staff must copy any-
thing in paper format. Works that are too fragile will be mi-
crofilmed and not photocopied.  They will not photocopy any-
thing that they believe will be damaged by photocopying. The
researcher can copy from microfilm or microfiche.  Costs
start at 25 cents per page and go up from there.  The Newberry
states that they will only reproduce copyrighted materials with
the principle of “fair use”. They do not define what they be-
lieve to be fair use. I explained the principle of fair use in the
first article of this series (see the April newsletter and below).
The Library also warns that you assume all responsibility
regarding copyright of library material.  However, they go on
to state that if you need more than 50 photocopies from one
book or film that they will make a you a microfilm or reader-
printer copy.

I received an e-mail in which a representative of the Fam-
ily History Centers stated that they interpreted the fair use
“clause” to be 10% of a record or 10 pages whichever is the
least amount. They have placed copyright notices on all of
their films. They also note that copies made by digital camera
must abide by this rule.  Similar to the Newberry Library,
they warn that FHC patrons alone are responsible for copy-
right actions taken by the holder.  Let’s review the principle
of fair use.

Fair use is a principle of law and not a “clause”.  The
Church of the Latter Day Saints may interpret the fair use
principle as 10% or 10 pages but that is not how the courts
interpret it.  The fair use principle allows limited copying of
copyrighted works for the purposes of commentary, criticism,
news reporting, teaching/education and parody.

There are several factors that the court looks at with re-
gard to potential copyright violations.

First, the character of the work is examined.  Is it a cre-
ative work?  In this case, no.  These microfilms are copies of
factual data (not including copyrighted books they micro-
filmed) such as names and dates.  This type of data is consid-
ered public information and cannot be copyrighted.  There-
fore, the principle of fair use does not apply.  The format in
which the data is presented, however, can be copyrighted.
An example would be if I decided to make a “compilation”of
the records.  The format in which I present the compilation
can be copyrighted since it was through my creative endeav-

ors that I designed the format.  It is possible that the FHC
could argue that the way they photographed the records and
then microfilmed them is creative and thus, copyrightable.

Second, the court will determine whether you (the copier)
are going to use the copies for commercial, educational or
historical purposes.  In this case, I am assuming that most
FHC patrons are making copies for genealogical/educational/
personal purposes.  Placing this within the principle of fair
use.

Third, the court will look at how much of an original
work is being copied?  Not really relevant in this case but for
the sake of discussion… Generally, you should only be copy-
ing a portion of a film and not the entire film.  Note that the
courts have not set a 10% limit.  This would be a difficult
determination in most cases and is very fact specific.  Once
again, only copying a portion of the work (film) places this
use within the principle of fair use.

Fourth, the court will determine just how much your cop-
ies will financially affect the marketability of the original work.
Making copies of original factual records for genealogical
purposes and not commercial purposes should have no finan-
cial impact on the FHC’s continual rental of these films.
Particularly since they don’t sell these films.  Taking all of
these factors into consideration, making copies from these
films will most likely be considered fair use even if you cop-
ied more than 10% of the film.

I have not seen this 10% rule in writing at the FHC that I
patronize nor have I seen it enforced.  In order to enforce this
rule, the FHC would have to maintain a frame/picture tally
for every film and then determine 10% of the total on thou-
sands of films.  I do not believe that these numbers are con-
tained in their records.

Be aware that I am not advising you to copy entire films
nor am I suggesting that it’s a good idea to “fight” the
Newberry or FHC rules. The purpose of this article is to ad-
vise you of important rules and the practical application of
the principle of fair use. As I stated in the first article, always
ask yourself why you are making the copies and keep these
fair use factors in mind.  In addition, remember to respect the
rights of the author or creator.

This article discusses general legal issues sur-
rounding copyright and is not intended to give
any specific legal advice.  The opinions in this
article are solely my own and are not the opin-
ions of the Computer Assisted Genealogy Group
of Northern Illinois.

Makin’ Copies
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Other Group Events Compiled by Beverly Levine Smallwood

27-29 JUN 2002 - SPRINGFIELD, ILLINOIS

East to West (Midwest, That Is)
Palatines to America National Conference
http://www.palam.org/events.htm

30 JUN - 07 JULY 2002 - DES MOINES, IOWA

33rd Annual International
AHSGR CONVENTION

See AHSGR website for details.
http://www.ahsgr.org/calendar.htm

08-11 JUL 2002 - SPRINGFIELD, ILLINOIS

Illinois State Genealogical Society's 8th
Annual Genealogical Institute of Mid-

America
LLOYD BOCKSTRUCK, SANDRA H. LUEBKING,

MICHAEL J. O'NEILL, PAUL MILNER
http://www.rootsweb.com/~ilsgs/gima/gima1.htm

09 JUL 2002 - 7PM
FREMONT LIBRARY IN MUNDELEIN

Citizenship and Your Immigrant Ancestor
BY MARIAN RICHTER SCHUETZ.
Lake County Genealogical Society

http://www.rootsweb.com/~illcgs/meetings.htm

09 JUL 2002 - 7:30 PM
Probate - It's more than just a will

CAROL KNIGGE

Schaumburg Township District Library
Genealogy Group

11 JUL 2002 - 6PM - NEWBERRY LIBRARY

The Children Are Coming:
A History of Orphan Trains

Newberry Friends of Genealogy (call 312-255-3510)
http://www.newberry.org/nl/genealogy/

L3gfriends.html

11 JUL 2002 - 7PM $5 TO NON-MEMBERS -
MCHENRY COUNTY COLLEGE

TONY BURROUGHS

Mysteries of the Soundex
McHenry County Genealogical Society

http://www.mcigs.org/MeetingNew.htm

13 JUL 2002 - 10:30AM - SCHAUMBURG LIBRARY

TMG (The Master Genealogist)
User Group Meeting

http://www.rootsweb.com/~ilcaggni

13 JUL 2002 - 2PM - SCHAUMBURG LIBRARY

POINTers in Person
Chapter #27 - Italian Genealogy Group

Geneva Shay presents “How To Search Cemeteries”
http://www.rootsweb.com/~itappcnc

13 JUL 2002 - DES MOINES, IOWA

Black Roots: Tracing the Family Tree
TONY BURROUGHS

Iowa Genealogical Society
http://www.iowagenealogy.org/Conference/

2002Burroughs/020712_tb.htm

13 JUL 2002
Whitewater, Wisconsin

German Interest Group
Wisconsin Workshop on German States
http://www.rootsweb.com/~wigig/workshop.html

14-18 JUL 2002 - DEARBORN, MICHIGAN

International Roots Conference
http://rootsconference.com/Index.html

15 JUL 2002 - 7PM - BEACH PARK VILLAGE HALL

Passenger and Immigration Lists Index
DEBBIE BLUETT

Zion Genealogical Society
http://nsn.nslsilus.org/wkkhome/zion/index.html

19-21 JUL 2002 - SASKATCHEWAN, CANADA

2002 FEEFHS Convention
Discovering Our Links in Europe

http://www.feefhs.org/conf/02reg/02reg-hp.html

31 JUL 2002 - NAPERVILLE FHC
Preserving Our Family Photo Heritage

BY JANET SOLIS

To register for this class: email deanna@spingola.com
or call the FHC at 505-0233

04-09 AUG 2002 - TORONTO

IAJGS International Conference on Jewish
Genealogy

http://www.jgstoronto.ca/Conferences2.html

07-10 AUG 2002
Federation of Genealogical Societies (FGS)

Ontario Convention Center, Ontario, California
http://www.fgs.org/2002conf/FGS-2002.htm

http://www.palam.org/events.htm
http://www.ahsgr.org/calendar.htm
http://www.rootsweb.com/~ilsgs/gima/gima1.htm
http://www.rootsweb.com/~illcgs/meetings.htm
http://www.newberry.org/nl/genealogy/L3gfriends.html
http://www.newberry.org/nl/genealogy/L3gfriends.html
http://www.mcigs.org/MeetingNew.htm
http://www.rootsweb.com/~ilcaggni
http://www.rootsweb.com/~itappcnc
http://www.iowagenealogy.org/Conference/2002Burroughs/020712_tb.htm
http://www.iowagenealogy.org/Conference/2002Burroughs/020712_tb.htm
http://www.rootsweb.com/~wigig/workshop.html
http://rootsconference.com/Index.html
http://nsn.nslsilus.org/wkkhome/zion/index.html
http://www.feefhs.org/conf/02reg/02reg-hp.html
http://www.jgstoronto.ca/Conferences2.html
http://www.fgs.org/2002conf/FGS-2002.htm
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03-05 OCT 2002
Iowa Genealogical Society

Annual Conference
Marshalltown, Iowa

Your Elusive Ancestor
SHARON DEBARTOLO CARMACK

http://www.iowagenealogy.org/Conference/2002Fall/
fall_main.htm

28 SEPT 2002 - 8AM-4PM
Fox Valley Genealogical Society Fall Conference
Unlocking Ancestral Mysteries

HENRY Z "HANK" JONES
http://members.aol.com/fvgs1/worksh01.html/

Grace United Methodist Church
300 E. Gartner Road, Naperville

04-06 OCT 2002
Polish Genealogical Society

2002 Conference - Basics & Beyond
Ramada Inn, 6600 N. Mannheim Rd., Rosemont

Meeting Handouts for Map Maker by Chris Kite
Edu update, goal to map of gene migrations http://www.molecular-genealogy.byu.

Europe 1500’s & 1600’s  http://www.ancestry.com

Principal Seats of War in Europe, I. 1618-1660 & 1700-1721
From The Historical Atlas by William R. Shepherd, 1923
http://www.1uptravel.com/worldmaps/history-europe49.html

http://www.ancestry.com

Polish Borders – Family Tree Dec 2000
Napoleon’s Army in Russia – use ideas for family migration?

Rhine River Valley – Kiser and other lines - http://www.calle.com/world/
English Colonies - http://www.ancestry.com

Shenandoah Valley 1716-1780
http://www.harringtons.org/documents/virginia/HarringtonInVirginia070998.htm

UT Library Online Migration from Eastern US - http://www.lib.utexas.edu/maps/histus.html

Wilderness Road And Kentucky 1774-1785 - Drawn under supervision Samuel Cole Williams,
Pg #62 Enlargement, showing Rivers, Towns, Villages, Forts & Cumberland Gap.

http://www.rootsweb.com/~usgenweb/sc/sca_maps.html

US Migration, Rates of Travel, Slavery & War - http://www.ancestry.com
Migration from VA to IL, IA, & MO – farms & great-great-grandmother’s letter

Immigration Ships & Artwork - http://www.kinships.com
County Boundary Historical Atlas - http://www.goldbug.com - purchase software

Topograpical Maps - http://www.topozone.com
National Geographic - http://www.nationalgeographic.com/xpeditions

Surnames - http://www.hamrick.com/names
http://www.cyndislist.com

Other Group Events Compiled by Beverly Levine Smallwood

http://www.iowagenealogy.org/Conference/2002Fall/fall_main.htm
http://www.iowagenealogy.org/Conference/2002Fall/fall_main.htm
http://members.aol.com/fvgs1/worksh01.html/
http://www.molecular-genealogy.byu
http://www.ancestry.com
http://www.1uptravel.com/worldmaps/history-europe49.html
http://www.ancestry.com
http://www.calle.com/world/
http://www.ancestry.com
http://www.harringtons.org/documents/virginia/HarringtonInVirginia070998.htm
http://www.lib.utexas.edu/maps/histus.html
http://www.rootsweb.com/~usgenweb/sc/sca_maps.html
http://www.ancestry.com
http://www.kinships.com
http://www.goldbug.com - purchase software
http://www.topozone.com
http://www.nationalgeographic.com/xpeditions
http://www.hamrick.com/names
http://www.cyndislist.com
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You will receive a warning that this could slow your
system down, so if you have an older system you might
want to reconsider.  Click OK to save the change.  You
will now see a tag at the top of the person view that tells
you the closest blood relationship between the person
displayed and the target person.  Now when I click on
cousin Lee, it tells me that he is my 1st cousin 1 time
removed.  This can be informative as you are entering
data.

Of course, you can always calculate the relationship
between any two individuals with the Relationship Cal-
culator, accessed through the Tools menu or by press-
ing CTRL+R.  Enter the two ID numbers and click on
Calculate.  It shows the relationship between the two.
If there is a blood relationship, you may click on Pro-
genitors to see all the common ancestors between the
two.

The Relative Auto-tag is for display purposes only;
it does not print on reports.  If you want a relationship
report, create a Kinship report in Custom Report Writer.
This report allows you to select a target individual, or
prompt for the ID number each time it is generated.  You
may decide on the "Options 1" tab whether to include
ancestors, descendants, cousins, or spouses of relatives.
The number of relationships to calculate affects both the
length of the report and the time it takes to generate it.
Also, really distant relationships like 5th cousin twice
removed are somewhat meaningless to the non-gene-
alogist so it is best to limit the number of generations.

Another report to consider is the Relationship Chart.
This one creates a box chart to illustrate the relationship
between any two individuals from their common ances-
tor.  It starts with the common ancestors at the center
top and drops down through the generations on the right
and left with connectors describing the relationships (sib-
lings, 1st cousins, 2nd cousins, etc.) to the two target
individuals.  This is a good way to demonstrate relation-
ships to the non- or neo-genealogist who may not un-
derstand the meaning of third cousin twice removed.

Relationships.  They're what genealogy is all about.

¹ In version 5 it is set in File > Preferences > Current
Project Options, Other

Tool Tips for The Master Genealogist
by Beverly Levine Smallwood

Calculate Relationships Automatically
TMG provides a convenient way to show relation-

ships between individuals.  The Relative Auto-Tag dis-
plays the relationship of any person you view to a se-
lected person (usually you).  In version 4.0x, it is set
from the Tools menu.¹  Go to Options and click on the
Tags tab, then place a checkmark next to the Relative
Auto-tag and enter the ID number of your target indi-
vidual.
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CAGG-NI Quick Tips
Show Desktop

Have you ever had too many windows open and
wanted to get to your desktop without having to mini-
mize all your windows? Well, there is a quick way to do
this. Of course, with windows, there is always more than
one way to do things. The fastest way is to click on your
‘Show Desktop’ icon. This icon is on your task bar to
the right of your ‘Start’ button and looks like a pencil
on a desk pad.

Another way is to minimize your windows all at once.
to do this, right click on an empty spot on your taskbar.
A menu will pop up from which you can select ‘Mini-
mize All Windows’. If you have so many windows open
that you can’t find an empty spot on your taskbar, you
can always right click on the time shown at the extreme
right of the task bar. Try it now!

New Feature This Month
CAGG-NI Quick Tips is a new feature, by CAGG-NI

members, for CAGG-NI members. Just a few ‘Tricks of
the Trade’ to make your surfing life easier. If you have a
tip for our members, why not contact us and we’ll fea-
ture it in a future issue? You can find the newsletter edi-
tor by clicking: HERE.

Opening Windows Explorer
Here’s a quick and easy way to open your Windows

Explorer without navigating through countless menu
options and minimizing a lot of applications. Just right
click on your start button and choose ‘Explore’. Your
Start button is always visible so you’re never more than
two clicks away from Windows Explorer! Try it!

Did You Know . . .
. . . that if you are using Microsoft

Internet Explorer, you can use your
space bar to page down on a web
page?

mailto:JimboDeuce@Yahoo.com
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